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Introduction

Let Rego be your guide. 
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• Take 5 Minutes

• Turn to a Person Near You

• Introduce Yourself

• Business Cards

Let Rego be your guide. 
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Introductions



• Introduction
• Open Workbench Integration with CA PPM

• Staffing via CA PPM
• Opening a Plan 
• Preferences 

• Quick Access Toolbar - quick commands & 
shortcuts

• Quick Search and Quick Filter - find now 
items

• Views and Filters - good to knows

Agenda

• Projects
• Work Breakdown Structure - the shortcuts
• Dependencies - the quickies
• Assignments – quick assignments & transfer 

assignments
• Autoschedule - magic button? 
• Baseline - did you know
• Copy Plans - shortening plan creation time

• Plan Closure – the plan’s ‘hot’ list



• Full bidirectional connection between CA PPM and OWB.

• Stop relying on multiple spreadsheets and applications for data.

• Real-time progress updates on OWB project schedule through CA PPM 
Timesheets.

• Repeatable processes and centralized data are essential in providing 
accurate reports and actionable metrics.

• Uses the same algorithms as CA PPM for seamless scheduling.

Let Rego be your guide.
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Why Integrate OWB with CA PPM?



Staffing
via CA PPM



Resources should be staffed to the project in CA PPM before the project 
schedule is opened in OWB

Resource and Calendar Data should be updated and maintained in CA PPM 
as CA PPM ‘owns’ Calendar and Resource data.  Changes made in OWB will 
not be copied back to CA PPM.  

Note: This does not apply to Resource Assignment information on Tasks.

Let Rego be your guide.
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Staffing



Staffing: Team Tab/CA PPM 

• To list all system primary roles while allocating, use the ‘Is Role=Yes’ filter option, then 
multi select from the results.
• Configure the view to list more than the default 20 results (to 40 or 50 to a page), as 

results can frustratingly list over multiple pages.
• Use ‘Add and Select More’ to remain on the Select Resource view to continue selecting 

all of the required roles and/or resources.
• Always adopt the 1 to 1 (role to named resource) mapping rule: 

• Do not allocate a single role >100% to represent two or more resources.
• Add the same role type twice or more if required, then apportion the percentages 

accordingly to each role.

• Use the ‘Add/Update by OBS’ option to bulk allocate resources within the same OBS 
unit. Ideal for departmental overhead/BAU projects.
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Demo Staffing



Projects
Open Plan



Opening A Plan

• When to use ‘Read-Only’ (no lock is applied)
• When reviewing/analyzing a plan.
• When saving a plan off-line.
• Why lock a plan just to view the detail.

• When to use ‘Read-Write’ (locks the project/plan)
• When updates are to be made.
• Allows only one person to update a plan at any one time.
• Save at regular intervals, no auto-save option.
• Always close the plan after updates are complete.
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Opening A Plan: Best Options
• Managing locks:
• Closing the plan drops the lock.
• Only use the CA PPM ‘Unlock’ option if:

• An exception has occurred between the CA PPM-OWB connection.
• You need to unlock a plan quickly for another user to apply changes.

Note:  Refrains the original user from saving the plan to CA PPM, best to close the opened 
plan and re-open after the updates.

• Saving an off-line PPM plan copy:
• Open the plan using ‘Read-Only’ option.
• Name the .rmp file appropriate to the ‘snapshot’ version.
• The off-line plan is a review copy and should not be saved back to CA PPM.

• Subsequent plans open quicker when File > Close is used against the 
originally opened plan, not File > Exit.
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Demo Open Plan
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Preference (Options)
Most Applied



Preferences (Options): Most Applied 

• General Tab
• ‘Show Tips at Startup’ can be disabled and enabled.
• ‘Recent Project File List Contains’ default is set to four (4) 

files, can be extended to nine (9).
• ‘View Shortcut Bar’ is used to add/remove the views displays 

to the left. Check the box to add back the views, if they have 
been removed.

• Defaults Tab
• ‘Loading Pattern’ is the spread of hours against assignments, 

setting the most typically required type here, saves time 
setting every time an assignment is applied.

• ‘Auto Calculate ETC’ adds assignment ETC, based upon the 
resource’s project availability.

Let Rego be your guide. 15

Use Preferences>Options to apply the ‘global’ settings to be retained when OWB is 
opened.



Preferences (Options): Most Applied 
• Locations Tab

• The set of default views can be made ‘Corporate’, which renders 
them read-only. 
• This protects the original views from being overwritten when additional 

views are created.
• Apply the below location mapping to protect:
• Corporate View Library - C:\Program Files (x86)\Open 

Workbench\Views\Standard_en.rwl.
• User View Library - C:\Program Files (x86)\Open 

Workbench\Views\User_en.rwl.

• WBS Tab
• ‘Summary Levels Label’ supports the ability to label the available 

summary level hierarchy.
• As the WBS is built within the plan, the ’Type’ field will list the 

label names defined here.
• When labelling, make sure to insert/add the name while 

respecting the top-down relationship. 
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Corporate views display a building 
graphic against the view icon.



Demo Preferences



Quick Access Toolbar
Quick Commands



Quick Access Toolbar: Quick Commands

Let Rego be your guide. 19

• The ‘Quick Access Toolbar’ contains a series of shortcut icons, 
initially located above the ribbon.
• Commands can be added and/or removed from the default 

layout.

• The toolbar can be moved to above or below the ribbon.
• When the customize dropdown is selected, options to minimize the ribbon and 

create custom commands is made available.



Let Rego be your guide. 
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Quick Access Toolbar: Shortcuts 
• For functions that are used on a regular basis, try assigning a shortcut via the 

Keyboard Customise feature.

• The below example assigns the ‘Ctrl+Alt+I’ keystrokes to the ‘Zoom In’ command.



Quick Search And Quick Filter
Find Now Items



Quick Search And Quick Filter: Find Now Items
• ‘Quick Search’ is an excellent way to list tasks and/or milestones on 

the fly:
• Simply enter either the full or partial related text directly into the search 

text field.
• The results instantly start listing in the plan.

• ‘Extended Find’ is similar to a permanent filter, where multiple 
conditions can be applied for a more detailed search, however 
these cannot be saved.

Let Rego be your guide. 22

• Quickfilter >‘Type’ dropdown is used to list any summary level 
(collapsed) or the complete/lowest level (expanded) plan 
content.
Note:  Summary level labels defined within Options > WBS, will 

list here.



Views And Filters
Did You Know?



Views And Filters

Let Rego be your guide. 24

• You can use ‘F3’ as the shortcut to display the ‘View Definition’ dialog box, used to 
edit views.
• A same value, for example ETCs or Actuals, can be added multiple times to include 

column totals, formatting and time-scales to display hours and or days of effort.

• Formatting fields enables 
additional dimensions to just 
displaying data.
• For example resource budgeting 

scenarios can be applied in days, 
if that works better than in 
hours.



Views And Filters

Let Rego be your guide. 25

• Filters can be added as part of a view or independently to be applied any time 
to an existing view. 
• Make sure you understand which views contain a filter, as the results could be 

misleading.
• If unsure about the results to a view, use the ‘Clear Filters’ filter within 

‘Filters & Sorts’, to list ALL results which overrides the default set 
against the view. 

• For example the ‘Status Update’ view, 
applies a ‘Not Equal to Completed’  
condition, displaying lines in the plan that 
have not started and/or are currently in 
progress.



Demo Filters
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Projects
Copying Plans



Copying Plans: Shortening Plan Creation Time

Let Rego be your guide. 28

• Plans can be copied from either an opened plan directly from CA PPM or a local 
template/plan (.rmp file).
• Navigate to your destination project in CA PPM and open it (Read-Write) into OWB, 

then open the source plan in CA PPM/local file. 

• Copy the plan, paste using the default 
‘Paste’, or ‘Paste Special’, then Save.



Demo Copy Plan
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Projects
Work Breakdown Structure



Work Breakdown Structure: The Shortcuts
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• The ‘Edit’ section in the ribbon, offers an 
alternative to column methods, when creating the 
WBS hierarchy.
• Once rows have been added directly to the plan, it 

is quicker/useful to use the shortcut icons to 
determine the type against each row.
• Remember the ‘Indent’ and ’Outdent’ icons only

apply to summary level hierarchy.

• The Edit section offers an alternative option to setting the hierarchical structure 
with a few clicks.  



Projects
Dependencies



Dependencies: The Quickies
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• For a more robust and logical schedule, especially if autoschedule is to be used, 
ALL tasks and milestones forming part of the prime delivery network must be 
linked.
• You can make quick linkages by highlighting rows and using right-click options to 

make chains and/or make predecessors of successors without using the dialog 
box. 
• Use the ‘Panning Overview’ within the CPM view to review the network and 

check for orphaned tasks.
• External dependencies can be applied by right-clicking on a task or milestone and 

selecting ‘Insert External Dependencies’ option.
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• A great way to view all network/s in your 
plan, is to select:
⎻ The CPM view.
⎻ Right-click within the main view window.
⎻ Select planning overview.

• From this view, you can see  at a glance 
any task(s) which are not connected to a 
network.

• Remember you can also define links between tasks/milestones in this view using the 
drag and drop method.
• Note: No summary levels are displayed in this view.

Dependencies: The Quickies



Projects
Assignments



Let Rego be your guide. 36

Assignments: Quick Assignments
• Defining task assignments doesn’t need to be onerous. You can use drag ‘n’ drop 

within a suitable view.

• Multiple tasks can be selected to assign 
to a resource.

• Multiple resources can be selected for 
bulk assignment.  

Remember: Remove (release) an assignment, 
you need to use the Task Properties >Resources tab.  
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Assignments: Transfer Assignments
• Assignments can easily be transferred from one role or resource 

to another role or resource.
1. Use the left dropdown to select the 

role/resource with the current 
assignments to be transferred.

2. Use the right dropdown to select the 
role/resource receiving the 
assignments. 

3. Click ‘All>’ for all of the assignments 
to be transferred.

4. Click OK for the assignments to be 
applied to the plan.



Demo Dependencies 
and Assignments

38



Projects
Autoschedule



Autoschedule: Magic Button?

Let Rego be your guide. 40

• Autoschedule is a great way to:
⎻ Resolve task and resource over-commitments.
⎻ Resolve dependency violations.
⎻ Calculate critical path.

• However it may not always be the answer to all your scheduling requirements. If the 
plan has not been set up correctly, it may not calculate to the most optimised 
results. 
• In many cases, Autoschedule is used to achieve a preliminary ‘first cut’, to then 

manually fine-tune thereafter.
• When used at a high-level, can be used to see for example resource ‘bottle-necks’ or 

violations. This helps with understanding who and when more resource may be 
required.
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Autoschedule: Magic Button?
• Deselect ‘Resource Constraints’ to 

see where the most resource is 
required to complete activities

⎻ The default is checked  to resource 
any over-commitments.

• ‘Selective-scheduling’ can be used to schedule only the rows you want 
⎻ Simply highlight the rows to be scheduled (row selector).
⎻ Then right-click on the highlighted row and select Autoschedule.



Let Rego be your guide. 
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Autoschedule – ‘Syntax’
• First, Autoschedule schedules work that has no flexibility

• actual work

• fixed assignments

• all work on locked tasks

• reduces the remaining availability accordingly.

• Next, Autoschedule processes the remaining tasks in order of a calculated priority (see below) subject to 
task dependencies. As each task is processed, remaining availability is reduced accordingly.

• The calculated priority is based on the following factors, considered in this order.

• If the task has a Must Start On or Must Finish On date constraint

• Task Priority (lower values rank higher)

• Task Float (lower values rank higher)

• If the task is started

• WBS order (i.e., the physical location that it is seen in a view; tasks towards the top rank higher)

• If a task "ties" with another task, the next factor is taken into account. Thus, for example, a task with no date constraint and a 
priority of 5 will be scheduled before another task that also has no date constraint and a priority of 5 if the first task's float is 
less than the second task's.

• Autoschedule gives priority to constrained tasks over non-constrained task, and to inflexible constraints 
(such as "Must Start On") over flexible constraints (such as "Start No Later Than"). Constraints are 
overridden when it would violate a dependency or over allocate resources.



Demo Autoschedule

Let Rego be your guide. 
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Projects
Baseline
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Baseline: Did You Know?

• These are some (not all) of the data 
‘captured’ during baselining.

This Data: Is Copied to: 

Start Baseline Start

Finish Baseline Finish

Duration Baseline Duration

Usage Baseline Usage

Loading Pattern Baseline Loading Pattern

• After baselining, plan variances can be 
analysed using the ‘Variance Analysis’ 
view.

• Negative values against tasks are date 
slippages or usage (hours) greater than 
baseline.



Demo Baseline
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Projects
Plan Closure
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Plan Closure: The Plan’s ‘Hot List’

• Let’s take a look at the initial items that will need addressing: 
⎻ Assignments – remove any unused ETCs.
⎻ Tasks - close for time, amend finish date and complete.
⎻ Staff - close for time entry.
⎻ Use views to help locate weekly exceptions, typically these views have 

conditional filters, for example the ‘Status Update’ view.



Let Rego be your guide. 
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Questions?



Instructions for PMI credits 
• Access your account at pmi.org
• Click on Certifications
• Click on Maintain My Certification
• Click on Visit CCR’s button under the Report PDU’s
• Click on Report PDU’s
• Click on Course or Training
• Class Name = regoUniversity
• Course Number = Session Number
• Date Started = Today’s Date
• Date Completed = Today’s Date
• Hours Completed = 1 PDU per hour of class time
• Training classes = Technical
• Click on I agree and Submit

Let Rego be your guide. 
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Thank You For Attending regoUniversity

Phone
888.813.0444

Email
info@regouniversity.com

Website
www.regouniversity.com

Let us know how we can improve! 
Don’t forget to fill out the class survey.

mailto:info@regoconsulting.com
http://www.regoconsulting.com/

